CUSTOMISE FIELDS AND LAYOUTS 2010

CUSTOMIZE YOUR FIELDS AND LAYOUTS
Step 1 Define your fields

Step 2 Customize your layouts
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Note: Changing the name of a field in the Define Fields box does not change the name of that field on your layout. After

redefining a field name, you must edit your layout to reflect this change.

CREATE A NEW FIELD

e Select Tools and Define Fields

=
Define Fields

Create, edit or delete fields

Create a new field, or select a field from the list to edit or delete. Select the desired action in the
Field Tasks menu to the left.

Create new held
Edit field
Delete field
Field Secunity

View fields for:
|Contacts -

Field Name Field Type Linked to Company Feld
) Address 1 Character Address 1

Manage product list Address 2 Character Address 2
i Mansge process list Address 3 Character Address 2

Manage drop-down lists

| m |-,.

Altemate Bxtension Character
Atemate Phone Phone
MName: Company Birth Date Annual Event
| ;Ljﬂﬂc;ﬂc}_ll_amdﬂ' City Character City
: Contact
! Cre‘;edi gﬁi}?ﬂ{)ﬁ ® Company Character Company
System Feld Contact Character
J Country Character Country
{Ei Customer ID Uppercase Customer ID oL
1 |n I I = I 1 »

e Choose View fields for: Contacts, Companies, or Groups

e |nthe Field Tasks box, click Create new field

e Typeinthe new field name and select a data type.

e Select an option from the Customize field behavior section:
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=

Define Fields )

@ Back @ £ Home

Enter field name and type

For each field you create or edit. you can select options to describe the field or
specify how the fild functions.

Field name:

Field data type:

Character -

Customize field behavior

| Allow Blank - This field can accept empty values
Generate History - Track changes made to this fields value in history
Primary Field - Copy this field when duplicating the recond

Use drop-down list:

< Back et > [ | Finish Cancel

0 Allow Editing - enabled by default. Disabling this option will prevent other users from changing the data
in this field

0 Allow Blank - enabled by default. Disabling this option will generate an error message if this field is left
blank in a new record.

0 Generate History - enabling this option will create a history entry if the data in this field is changed.
0 Primary Field - when duplicating the record, the data in this field will be copied to the new record.
0 Use drop-down list - you must have a drop-down list prepared before enabling this option (see next
page)
Select Next
" Define Fields et )

Back 2 Home
Qeack @ #

Customize field behavior

Specify formats or rules for entering data in the field.

Default value (optional):

Field format {optional):
o @ @@ o

Field length:
50

< Back et > | Finish [ cancal |
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e Select a Default Value if required
e If your data needs to be entered in a certain format use the Field Format
e Use the following placeholders to specify your field format:
0 #-numeric
0 @ - alphabetic
0 % - alphanumeric
e Set the field length remembering not to underestimate your requirements

onto or away from this field.

CUSTOMISE FIELDS AND LAYOUTS- 2010

e Select Next to Set field triggers. For example you can set an Activity Series to be launched when a user moves

Define Fields

9 Back

2 Home

Set field triggers

Cet = trigger on the field to automatically schedule an activity senes. launch a program, or
aunch a web site when entering, exiting, or changing information in the field.

When changing a field, launch
|,F\c’(iv'rty53ries - ew Custome
When entering a field. launch

| None -

When leaving a field. launch

| Nong -

Finish

Cancel |

CREATING A FIELD WITH A DROPDOWN

the field to add the list of values.

TO CREATE A DROP-DOWN LIST

e From Tools go to Define Fields.
o Select Manage drop-down lists from List Tasks

Before you can add a drop down list to a new field, you must create the list. Once the list has been created, you can edit
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[ Define Fields

(SxT)

@ Back

Create, edit, or delete drop-down lists

Create 3 new drop-down hist, or select 2 listto edit or delete. Select the desired achion inthe
Drop-down list tasks menu to the left

Type: Character
Created: 5/24/2006
0 tems

Mame: Activity Location

Company |1D/Status
Contact |D/Status
Couriries

Departments

Industry

Jobtitles

Last Results

Opportuniy Close Reasons
Opportunity Competitors
Opportunity Lead Source
Payment Method
Product Types

Product Unit of lssue

Type Description

sractes Lwvailable Hons
Character Master list of Cties
Character The categorization of a Company
Character The categorization of a Contact
Character Master list of Countries
Character Depatments where Contacks work
Character The Industry associated wiha €.
Character Jobtiles which can be assignedt...
Character The Lost Results with 2 Contact
Character
Character
Character The source which lead to the cre...
Character
Character
Character

m

-

Define Fields

Home
e  (Click Create drop-down list.
e Typein a name for your drop-down
e The Define Fields - Enter drop-down list values dialog box appears.
=)
@Back @ ‘E Home
Enter drop-down list name and type
Drop-down list name:
Regions
Type:
Character -
Description(optional):
| Allow users to edit items in this list
V| Automatically add new items users enter fo the fist
< Back HNexdt > Erish | | Cancel

Note: You cannot enable the Automatically add new items... option without enabling the Allow users to edit... option.
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Define Fields &f]
Enter drop-down list values
Value Deecription Add
North
South Dx
East
< Back | | Finish Cancel

Define Fields

Once your drop-down values and descriptions have been entered, click Finish.

Click the Add button to add values for your drop-down list. Enter a Description for each value if desired.

MName: Regions
Type: Character
Created: 10/17/2007
4 ltems

Create, edit, or delete drop-down lists

Create 2 new drop-down list, or select a list to edit or delete. Select the desired action in the
Drrop-down list tasks menu to the left.

List Name

Company 1D/Status
Contact |D/Status
Countries

Departments

Industry

Jobtitles

Last Results

Opportunity Close Reasons
Opportunity Competitors
Opportunity Lead Source
Payment Method
Product Types

Product Unit of lssue
Refemsd By

Regions

Type

Character
Character
Character
Character
Character
Character
Character
Character
Character
Character
Character
Character
Character
Character
Character

Description

The categonzation of a Company

The categorization of a Contact
Master list of Countries

Departments where Contacts work
The Industry associated witha C...
Jobtitles which can be assignedt...
The Last Results with a Contact

The source which lead to the cre...

Who the lead was Referred By

m

Home |

Select Finish

FIELD FACTS

e You can change the name of any field.

To add this list to an existing field or to create a new field for this list, click the Home button and find the field you want to
add the drop down list to.
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e You will not be able to include special characters (such as <, >, $, ? or :) in a field name.

DESIGNING LAYOUTS

e From the Tools menu, go to Design Layouts
e  Click the appropriate layout type: Contact, Group or Company.

R Layout Designer - CHlechOne
File Edit View Format Help
IS L B

Toolbox 3 |
Drawing

Field
Pointar
Field
Meme Field
Picture Field
Yes/Mo Field
Record Manager
Aeccess

il [

=
L [[]

dIf Rl

The Layout Designer appears
DESIGN TOOLS

The Layout Designer's Toolbox contains two buttons Drawing and Field.

DRAWING TOOLS

| h  Fointer

The Pointer tool will allow you to select the fields in the layout.

Note: If you hold your Shift or Ctrl keys, you will be able to select multiple fields and field labels. You can also select

multiple fields and/or field labels by clicking outside of a field and then dragging across the area containing the fields
and/or field labels.

When you click a field or a field label to select it, a thick black border surrounds the field.

[ ] ] [ ]
- EETR -
L] | | | |

Note: The small squares within this black border are called sizing handles. When you place your cursor over one of these
sizing handles, your cursor will change to a two-way arrow; allowing you to click and drag the field to a different size.
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When you place your cursor over other parts of the border, a four-way arrow will appear; allowing you to click and drag
the field to a new position.

| A._—I Text

The Text tool will allow you to enter permanent text into your layout.

| gﬂ', Image

The Image tool will allow you to insert a picture into your layout. Click the image tool and draw out a field on your layout
that will contain this image. An Open dialog appears, for you to Browse for your picture file.

| [[] Rectangle

The Rectangle tool will allow you to drag a rectangular shape into the layout.

| () Elipse

The Ellipse tool will allow you to drag a circular shape on the layout.

‘FIELD TOOLS:

| Field
The Field tool will allow you to insert additional Contact, Company or Group fields into the layout.

| Memna Field

The Memo Field tool will allow you to insert a memo field into your layout.

| @ Yesho Field

The YesNo Field tool will allow you to insert a yes/no field into your layout. The YesNo field appears as a small square and
will either hold a check mark or will be blank. A field must be defined as a YesNo Field before it can be added to the layout.

| Record Manager

The Record Manager tool will allow you to insert the Record Manager field into your layout. The record manager reflects
the database User that controls the contact record.
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appears:

Select Field

Pleaze choose a held:

CUSTOMISE FIELDS AND LAYOUTS- 2010

TO ADD A FIELD TO YOUR LAYOUT

e Select the Field button on the left
e Draw out the field on your layout. Your mouse pointer turns into a crosshair and the Select Field dialog box

Address Name
Alternate Ertension
Annual Contracts
Customer 1D

Fax Extension

First Mame

First Purchase
Home Address 3
Home Extengion
Last Attempt

Last Edited By
Lazt Name

Last Results

Last frs Purchazes
Middle Hame

i obile E xtension

153

Include a label

Mew Field

defining a new field.

7 City (Field)

Note: To add a brand new field, select the New Field button to launch the Define Fields wizard and begin the process of

PROPERTIES DIALOG BOX

Background Coler
Border Style
Font
Font Color
Text Alignment

= Behavior
Enter Stop Enabled
Enter Stop Index
Tab Stop Enabled
Tab Stop Index

O Data
Field Value

= Layout

Location

Size

[ ] window
Fixed3D
Tahema, 8pt
- ControlText
Left

True
4
True

13
Gity

392,93
176. 21

Appearance
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Select View Properties Window or press F4 to show the Properties window.

You can modify the properties for any data Field, Text field, Picture, Rectangle, Ellipse, Tab or Panel (background) from this
window.

For example: If your picture does not show correctly, go to the Behavior Properties and change the Size Options to
Normal.

TAB STOPS
To view the Tab Stops click the View menu and Show Tab Stops. In this view you will not be able to view the Toolbox or

the Properties windows. Go back to the View menu again, and then deselect Show Tab Stops to return to Design Layout
view.

Layout Designer - CHTechOne [Tab Stops View]

Address 2

Address 3

Web Site

- - - |E-mal

E-mail
Last Letter |Letter Date

TO RESET THE TAB STOPS

e From View Tab Stops select Clear.
e Select each field in turn to add your own tab tops.
e Alternatively, you can right click on the field and then type in the new index from the Set Index box.

r Set Index ﬁ

Enter the new index:

g
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Field type
Address

Annual
Event

Character
Currency

Date
Date/Time

Decimal

E-mail

Initial-Caps
Lowercase
Memo
Number
Phone
Picture

Time

CUSTOMISE FIELDS AND LAYOUTS- 2010
ACT DATA TYPES

Data allowed in fields

Alphanumeric characters (letters, numbers, or symbols).

Events that recur annually, formatted according to the date settings in the Microsoft Windows Regional
Settings control panel. The field contains a drop-down date selector.

Alphanumeric characters (letters or numbers).

Numbers formatted according to the currency settings in the Windows Regional Settings control panel.

Dates formatted according to the date settings in the Windows Regional Settings control panel. The field
contains a drop-down date selector.

Date and time formatted according to the date and time settings in the Windows Regional Settings control
panel. The field contains a drop-down date/time selector.

Numbers and decimal points.

Alphanumeric characters. The address entered in the field becomes an active link to open an e-mail
message.

Alphanumeric characters, formatted with a capitals at the beginning of each word.

Alphanumeric characters, formatted in all lowercase letters. The Shift and Caps Lock keys have no effect.

Alphanumeric characters (letters, numbers, or symbols).

Numbers only. Letters typed in this field are ignored.

Numbers only.

Pictures in .bmp, .gif, .jpg, .png, .ico, .emf, or .wma format.

Time of day formatted according to the time settings in the Windows Regional Settings control panel. The
field contains a drop-down time selector.
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Uppercase Alphanumeric characters, formatted in all uppercase letters. The Shift and Caps Lock keys have no effect.

URL Alphanumeric characters. The address entered in the field becomes an active link to a URL.
Address
Yes/No Check box. If the check box is selected, it has a "Yes" value. If the check box is cleared, it has a "No" value.
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